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Disclaimer  

The contents of this document are subject to revision without notice. DEIF A/S shall have no liability for any 
error or damages of any kind resulting from the use of this document. DEIF A/S customers may copy and 
use the information from this manual in own manuals without additional permission from DEIF A/S. 

The English version of this document is the original language, and always takes precedence if there is any 
discrepancy with a translation of the document. 

 

 

Trademarks 

DEIF DEIF is a registered trademark of DEIF A/S 

Torx ® Torx® is a registered trademark of Acument Intellectual Properties, 
LLC in the United States or other countries 

All trademarks mentioned in this manual are the properties of their respective owners. 

 

 

 

Copyright 

© Copyright DEIF A/S. All rights reserved. 
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1. Introduction 

This document describes the preventive (scheduled) service recommended for the IMD as well as 
corrective maintenance and storage requirements. Furthermore, the display, errors and warning as well 
as some operational procedures that can be used in trouble shooting are described. Although this 
manual stands on its own, it is expected that turbine manufactures using the IMD will incorporate parts 
of this document in their service and maintenance documentation.   

The document can be printed on a monochrome printer. However, the details in the pictures will be 
better if a colour printer is used. 

1.1 Conventions 

The following conventions are used in this document: 

Used in document Description 

Monotype font Used when describing a path or text input in a machine human interface 

Blue underlined font Used to indicate that the text is also a hyperlink 

  Used to illustrate a space and Enter characters 

 A yellow symbol illustrates hazard type (this symbol is an example for general 
hazard). There are different types such as electrical, chemical and so on. 

Danger! A signal word used to indicate an imminently hazardous situation, which if not 
avoided, will result in death or serious injury. (ISO 3864) 

Warning! A signal word used to indicate an imminently hazardous situation, which if not 
avoided, could result in death or serious injury. (ISO 3864) 

Caution! A signal word used to indicate a potentially hazardous situation, which if not 
avoided, could result in minor or moderate injury. (ISO 3864) 

 A blue symbol illustrates a need for mandatory action. In this example read 
instructions. Other types of blue symbols exist and always indicate mandatory 
action. 

 A symbol used to draw attention to extra information or an action that is not 
mandatory 

1.2 Referenced documents 

Document no. Title 

4189360016 IMD 100 initial configuration and verification manual 

4189360015 IMD 100 integration manual 

4189360019 IMD manager user manual 
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2. Safety precautions 

 

Attention 

Company policy and local regulations regarding PPE must always be followed, regardless 
whether the PPE is shown in this manual or not. 

International standards such as IEC 364 and any other relevant international or national 
standard regarding safety must be observed. Only qualified personnel who is fully capable 
of recognizing, understanding and judging the dangers of the task at hand may perform the 
work.  

 

2.1 Mechanical work 

2.2 Electrical work 

 

 

 

 

Danger! 

Service of the IMD is always done in a turbine. Follow the turbine manufacture’s instruction 
to ensure safe conditions for your work. 

 

Caution! 

Assess the weight of the IMD (see datasheet) with regards to lifting and placing it in the 
designated location in the cabinet. Use lifting aid or a second person if necessary.   

 

Disconnect power 

Ensure that all power is disconnected when working with the IMD, except for during 
commissioning and service. 

 

Danger! 

Risk of burns and electrical shock from short circuit, electrical arc and uninsulated wires. 

Live work is not permitted, except for during verification, commissioning, and service.  

Observe local regulation when working with electrical components. 

 

Danger! 

Risk of burns and electrical shock from short circuit, electrical arc and uninsulated wires. 

Commissioning and maintenance work on this device may only be carried out by a qualified 
electrician.  

When the IMD has been powered, there is a risk of stored energy even when the power is 
disconnected. Wait 5 minutes after the power is disconnected and verify zero energy 
according to company procedures on the outputs before performing any work. 
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Caution! 

Risk of electrical shock from touch current if the protective earth is removed when the IMD is 
energized. 

Do not remove the protective earth is removed when the IMD is energized.  

2.3 Thermal precautions 

 

 

 

 

Figure 1 Hot surface areas 

  

 

Info 

During operation, the IMD can reach high surface temperatures. The temperature levels 
depend on the ambient temperature inside and outside the cabinet.  

 

Warning! 

Risk of severe burns. 

The heat sink of the IMD can reach high temperature. 

Do not touch until the surface (see pos. 1 in Figure 1 on page 9) is cooled down. 

 

Caution! 

Risk of burns. 

The sides of the IMD can reach medium high temperature. 

Do not touch until the surface (see pos. 2 in Figure 1 on page 9) is cooled down. 

2 

1 
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3. Avoiding damage to the IMD   

Certain situations may result in product damage and should therefore be avoided by observing the 
precautions described in this section. These situations are not likely to occur under normal use of the 
IMD, but might occur in the lab or during service.  

The situation list may not be comprehensive. Other, unknown situations that are not described in this 
section could occur.   

3.1 Connecting the safe energy 

Possible damage: Damage to internal power components. 

3.2 Switching mains ON and OFF 

Possible damage:  DC-link Pre-charge circuit damaged due to repeated MAINS ON and OFF 
operations 

 

How to avoid:  

If the MAINS connections are switched ON and OFF more than once, wait 60 seconds 
before switching ON after switch OFF. 

3.3 Overloading the ballast resistor 

Possible damage: Ballast circuit ((switch or resistor) damaged due to overload. 

 

How to avoid:  

• The ballast resistor value is adequate for the DC-link Vmax.  

• Never use single pulse longer than 1 s during safe energy test. 

• Wait 10 minutes (at 25ºC) if the IMD is restarted and the ballast resistor has been 
loaded (hot) 

3.4 Connecting the mains with overvoltage 

Possible damage: Total damage to the IMD. 

 

How to avoid:  

The mains supply must never exceed the range specified in the Data sheet. 

 

 

 

How to avoid:  

If the safe energy was disconnected from the SE terminals, the mains supply must be 
turned on before the safe energy is turned on. 
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4. IMD maintenance schedule 

The maintenance of the IMD is performed either as preventive or corrective maintenance. Preventive 
maintenance is performed at scheduled intervals to prevent faults from occurring. Corrective 
maintenance is performed either after a fault occurred, or because of an early warning given by the IMD 
or the pitch system. 

This section lists the preventive and corrective maintenance. 

Table 1 Maintenace actions list 

Action Type Interval Fault condition indication 

Cleaning the IMD Preventive 1 year IGBT / rectifier too hot (fault can also be 
caused by too high ambient temperature). 

Checking electrical 
connections 

Preventive 1 year Motor not functioning, no safe energy. The 
same faults can occur from other reasons. 

Checking the fan Preventive 1 year IGBT / rectifier too hot (fault can also be 
caused by too high ambient temperature). 

Checking corrosion  Preventive 1 year Holes in the IMD, large debris in the IMD. 

Replacing the fan Corrective None IGBT / rectifier too hot (fault can also be 
caused by too high ambient temperature). 

Fan not working warning (IMD 122C or later, 
IMD 135). 

The fault condition indication in Table 1 describe most common consequences if the action is not 
performed, or indications that the action should be performed. The given intervals are based on normal 
operating conditions as expected in a win turbine’s hub, within the environmental limits, specified in the 
IMD 100 datasheet. 

NOTE  Other corrective actions not mentioned in Table 1 should be performed by DEIF or its 
representative. 
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5. Preventive maintenance of the IMD 

The following tasks are recommended to be performed once a year: 

 

Disconnect power 

Disconnect the power to the IMD 

5.1 Cleaning the IMD 

Clean the IMD parts that are outside the cabinet from dust, oil and debris. Look inside the heatsink to 
ensure that no debris are trapped inside. The following picture depicts a loose nut inside the heatsink 
that can damage the fan and therefore must be removed.  

 

 

 

 

NOTE:  The fan cover may look different from the fan cover depicted in the picture.  
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5.2 Checking electrical connections 

 

 

Figure 2 IMD 122 connections overview 

NOTE   Heatsink, fan house, PE connections of early production units of the IMD 122 C are the same 
as in IMD 122 B.  

IMD 122 B 

X1 in IMD 122 C 
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MAINS + PER-BALLASTSAFE ENERGY

X1 MOTOR (under the cover)+ PE 

W                   V                     U            PE

X1

 

Figure 3 IMD 135 C connections overview 
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Check that all electrical connections are ok: 

1. Check that all X1 PLH 16 connectors are pressed all the way down. Pull all wires gently to ensure 
that none of them is loose. 

      

 

2. Check that X2, X3, X7, X8, and X9 connectors are pressed all the way down. Check that none of 
the orange locking handles is loose or broken. Pull the wires gently to ensure that none of them is 
loose. 

 

3. Check that all D-sub connectors used are hand tightened. 

5.3 Checking the fan 

1. Check that no fan blades are missing 

2. Verify that the fan at the back of the IMD (outside the cabinet) is turning and does not make an 
unusual noise (for example if the cover touches the fan). The fan must be activated to check this. 
Activating the fan can be done in two ways: 

a. Use the IMD manager to turn the fan on. Full description can be found in IMD 100 initial 
configuration and verification manual.  

b. Connecting 24 V DC directly to the fan (how to connect depends on the integration in the turbine 
and will most likely be different from customer to customer). 

 

Warning! 

This task requires electrical power. Be sure to take the necessary steps to avoid electrical 
shock and moving objects. 

5.4  Checking corrosion 

Check the IMD for visible corrosion such as rusty or salty pitting from area around connectors and screws.  

http://www.deifwindpower.com/


IMD 100 Service and maintenance manual 4189360017 Rev. E  Corrective maintenance of the IMD  

 

www.deifwindpower.com Page 16 of 81 

6. Corrective maintenance of the IMD 

The tasks described in this section might be necessary to perform within the lifetime of the IMD.  

6.1 Replacing the fan 

The fan is the only moving part in the IMD. In the event that the fan needs to be replaced follow the 
procedure described in this section. The fan comes already mounted on a new fan plate, which is 
replaced together with the fan. The type of the fan and fan plate depends on the IMD type: 

 

NOTE   Some IMD 122 C units might have IMD 122 B fan 

IMD 122 B / early production C type fan IMD 122 C type fan 

IMD 135 C type fan 
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6.1.1 Replacing IMD 122 B fan 

6.1.1.1 Required tools and accessories 

The tools and accessories in the following table are required for the fan replacement. 

Table 2 Required tools and accessories 

 Tool or accessory Torque Used to 

 Torque hexagon 
screwdriver 2.5 mm 

2.35 
Nm 

Dismounting and fastening screws of the fan 
plate 

 

Wrench, 12 mm  Hand 
tight 

Dismounting and fastening cable gland for fan 
wire 

 
Long nose pliers N/A Insert and pull cable tie 

 

Small cutter N/A Cut cable tie 

 

Press tool for ferrules N/A Press ferrules on wires (optional) 

 
Ferrules N/A Terminate wires to connectors (recommended, 

different size according to wire size) 

 

Small cable ties, 
approximately 2.5 mm 

N/A Tie the cable to the heatsink cover 

6.1.1.2 Procedure for replacement of the fan 

 

 

1. Disconnect the fan wires from their terminals (either DO terminal on the IMD or other connectors in 
the cabinet. 

2. Open the cable gland (inside the cabinet) that the fan wire is led through to the cabinet using a 12 
mm wrench. Keep all parts at hand. 

 

Disconnect power 

Disconnect the power to the IMD 
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3. From the outside of the cabinet, open the four fastening screws of the fan cover using a 2.5 
hexagon screwdriver. The fan cover may look slightly different depending on the model, but the 
procedure is the same. 

 
 
 

4. Open the fan plate 

 
 

5. Cut the cable tie holding the fan wire 
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6. Use the long nose pliers to take the used cable tie out. Be careful that it doesn’t fall into the heat 
sink. 
 

 
 

7. Pull the fan wire out and put the old fan plate (including the fan) away. 
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8. Twist the ends of the new fan wires 
 

 
 
 

9. Insert the wires behind the ballast resistor cable and into the hole in the heat sink 
 

 

       
 
 

10. Push the fan wire as much as possible through the hole. Thread a cable tie through the cable tie 
holder (the picture on the right shows the cable tie holder and cable tie from the inside without heat 
sink). 
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11. Use the long nose pliers to close the cable tie and tighten it. 
 

 
 

12. Cut the excess cable tie with the cutter. Ensure that the cut piece does not fall into the heat sink. 
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13. Mount the fan plate onto the heat sink cover using the 2.5 mm torque hexagon screwdriver.  
 

  

 

14. Pull the fan wire inside the cabinet until the insulation is higher than the heat sink. Ensure that the 
rubber sealer (pos. 1) is inside the hole. 
 

 

1 
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15. Thread the fan wire through the washer and gland nut 
 

 
 

16. Assemble the cable gland and hand tighten  
 

 

17. Test the fan as described in section 5.3 on page 15. Ensure the fan is blowing into the heat sink and 
not out of it.  
 

 

 

Warning! 

This task requires electrical power. Be sure to take the necessary steps to avoid electrical 
shock and moving objects. 
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6.1.2 Replacing IMD 122 C fan 

6.1.2.1 Required tools and accessories 

The tools and accessories in the following table are required for the fan replacement. 

Table 3 Required tools and accessories 

 Tool or accessory Torque Used to 

 
Torque Torx Tx25 
screwdriver  

3 Nm Dismounting and fastening screw of the fan plate 

6.1.2.2 Procedure for replacement of the fan 

 

 

1. Loosen the lock screw: 
 

 
 

 

Disconnect power 

Disconnect the power to the IMD 
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2. Pull the fan away from the locking screw and lift it from the left side: 

 

 

3. Insert the new fan into the fan house holding it on the left side and slide the fan into place. Make 
sure that all four holders are sliding under the holes (1) in the fan house: 

 

 

4. Fasten the lock screw according to torque in Table 3 on page 24: 

 

1 
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6.1.3 Replacing IMD 135 C fan 

6.1.3.1 Required tools and accessories 

The tools and accessories in the following table are required for the fan replacement. 

Table 4 Required tools and accessories 

 Tool or accessory Torque Used to 

 
Torque Torx Tx25 
screwdriver  

4 Nm Dismounting and fastening screw of the fan 
house 

6.1.3.2 Procedure for replacement of the fan 

 

 

Disconnect power 

Disconnect the power to the IMD 

 

1. Loosen the four lock screws: 
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2. Pull the cover away from the locking screw, lift it and put it aside (1). It will be used again. 
Pull the fan house to the right, lift it and discard it (2): 

 

 

3. Lubricate both contacts mounted on the heatsink cover on both sides with Nyogel 760G or similar 
silica-based lubricant: 

 

1 
2 
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4. Insert the new fan house onto the heatsink cover: 

 

 

5. Push the fan house to the left. Ensure that the both fans’ male contacts are completely pushed into 
the female contacts on the heatsink cover: 
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6. Fasten the lock screw according to torque in Table 4 on page 26: 

 

7. Mount the cover through the screw and push it to the right, ensuring that the cover ends are in the 
fan house slots: 
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8. Fasten the lock screw according to torque in Table 4 on page 26: 
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7. Operational procedures (how to) 

 

Info 

IMD with internal power supply must be powered by at least one of the following sources to 
operate: 

• Mains  

• Safe energy 

• External 24 V DC through X7 

 

Many of the procedures described in this section require power, and may result in movement of 
mechanical parts.  

 

 

 

Danger! 

Risk of burns and electrical shock from short circuit, electrical arc and uninsulated wires. 

When the IMD has been powered, there is a risk of stored energy even when the power is 
disconnected. Wait 5 minutes after the power is disconnected and verify zero energy 
according to company procedures on the outputs before performing any work. 

 

 

7.1 Brake test 

It is possible to manually test the brake output in order to verify that the brake is released and the motor 
can turn. Activating the brake test is done by using function 08 in the special commands. 

7.1.1 Prerequisites  

The IMD must be in Normal operation state, and the Device must be disabled (reg. 0x51 bit 2 = 1). 

7.1.2 Activation 

X4: Select “8:Brake test” in the “States and special commands” in the “Monitor and control” tab. 

 

Attention 

Only instructed and qualified personnel who is fully capable of recognizing, understanding 
and judging the dangers of the task at hand may perform the work. 

 

Warning! 

Risk of crashed bodily parts due to moving parts in the nacelle or hub. 

Be sure to stay away from moving parts, when being inside the nacelle or hub. 
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CAN/CANopen: send “8” to the special commands register (reg. 0x03) 

The IMD changes state to 40 – “Brake test”, turns the brake output (X2) on, and changes the “Brake 
output” LED indication in the X4 to on. 

7.1.3 Operation 

The IMD will remain in this state until “0” (Idle) is sent to special commands register (reg. 0x03).  

It is not possible to use the “Enable dev.” button or enable the device through CAN while the IMD is in 
brake test. 

7.1.4 Deactivation 

X4: Select “0:Idle” in the “States and special commands” in the “Monitor and control” tab. 

  

CAN/CANopen: send “0” to the special commands register (reg. 0x03).  

The IMD goes back to “Normal operation” state, turns the brake output (X2) off, and changes the “Brake 
output” LED indication in the X4 to off. 

7.2 Disconnecting AC mains from DC-link (Mains, disconnect) 

It is possible to disconnect the AC mains supply from the DC-link internally in the IMD (it has no effect 
on safe energy). 

 

 

Info 

This function is not supported in IMD 100 A version 
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7.2.1 Prerequisites  

• SE Vlow warning is not active 

7.2.2 Activation 

X4: Select “12:Mains, disconnect” in the “States and special commands” in the “Monitor and control” 
tab. 

  

The indication in the “Power source” group in the “Monitor” tab will change to show that the Mains is the 
energy source of the DC-link (will also change if the command is executed through CAN/CANopen): 

 

CAN/CANopen: send “12” to the special commands register (reg. 0x03) 

The IMD remains in state 1 – “Normal operation” and disconnects the AC mains from the DC-link. The 
flag “Mains, disconnect” changes from 0 to 1. 

 

7.2.3 Operation 

After the “Mains, disconnect” command is executed, the Mains stays disconnected, and the IMD is 
using the safe energy. The IMD will not reconnect the mains automatically unless a safety run is 
performed, and the DC-link voltage is below DC-link Vlow. 

Sending “0” to the special commands register (reg. 0x03) will not reconnect the AC mains supply to the 

DC-link.  

7.2.4 Deactivation 

NOTE  The Mains must be in OK state to be able to reconnect the Mains.  

 

Attention 

After executing “Mains, disconnect” command, safe energy is the only power source until 
“Mains, connect” command is executed. 

“Mains, disconnect” also cancels the LVRT timer if it is active. 
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X4: select “13:Mains, connect” in the “States and special commands” in the “Monitor and control” tab. 

  

The indication in the “Power source” group in the “Monitor” tab will change to show that the Mains is the 
energy source of the DC-link (will also change if the command is executed through CAN/CANopen): 

 
 

CAN/CANopen: send “13” to the special commands register (reg. 0x03). The IMD reconnects the AC 

mains to the DC-link. The flag “Mains, disconnect” changes from 1 to 0. 

7.3 Function verification 

Refer to IMD 100 initial configuration and verification manual (Document no.: 4189360016) for 
description of how to test or verify different inputs and outputs of the IMD. 

7.4 Manual operation 

It is possible to control the motor manually using digital inputs 10, 11, and 12 for service purposes. 
These inputs are intended to be connected to three switches in the pitch cabinet, and can be used with 
practically no regards to the logical state of the IMD. If Virtual limit switches (VLMS) are used, it is not 
possible to pitch past them in this mode. See section 7.5 on page 35 for pitching past the VLMS. 

7.4.1 Prerequisites  

• Manual operation must be enabled in the configuration.  

• Three switches must be connected to Digital inputs 10, 11 and 12 and 24 V DC. 

• The IMD must be in one of the states that allow entry to manual operation. This will be the case in 
most states. The SCI state must be according to the configured state (OK or Not OK). 

7.4.2 Activation 

The IMD is brought into manual operation mode by activating DI 12 (high) following by either DI 11 or 
DI 10 (rising edge). 
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7.4.3 Operation 

While in manual operation mode only activating DI 10 or DI 11 will move the motor (D10: “-“ direction, 
D11: “+” direction). The configuration parameters for manual operation will be used. 

If either RUN or RFE inputs are low, or the SCI, input changes state, the output to the motor will be 
disabled. 

No automatic actions (such as safety run) are performed while in manual operation mode. 

7.4.4 Deactivation 

Deactivate DI 12 (low).  

If the SCI state is configured to OK, the IMD always goes to normal operation state. 

If the SCI state is configured to Not OK, the IMD performs a safety run. 

7.5 Manual operation 360 

Manual operation 360 is the same as manual operation except that virtual limit switches (VLMSs) are 
ignored, and the motor keeps moving past the VLMS. 

7.5.1 Prerequisites  

• The IMD is in manual operation mode 

• Reg. 0x01 bit 22 (Manual operation 360) must be enabled. 

7.5.2 Activation 

The IMD is brought into manual operation 360 mode by activating DI 9 (high). 

7.5.3 Operation 

The VLMS are ignored. 

7.5.4 Deactivation 

Deactivate (low) DI 9 to go back to “Manual mode”. 

Deactivate (low) DI 12. To go back to normal operation state. If DI 12 is deactivated the state of DI 9 

does not matter. 

7.6 Manually activating the fan 

It is possible to activate the fan manually by using function 17 in the special commands. 

7.6.1 Prerequisites  

None. 

 

Info 

This function is not supported on IMD 122 A and IMD 122 B. 
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7.6.2 Activation 

X4: Select “17:Fan ON” in the “States and special commands” in the “Monitor and control” tab. 

  

CAN/CANopen: send “17” to the special commands register (reg. 0x03) 

The IMD will turn on the fan. 

7.6.3 Operation 

The fan remains ON until special command 18 is sent to the IMD. 

7.6.4 Deactivation 

X4: Select “18:Fan Auto” in the “States and special commands” in the “Monitor and control” tab. 

 

CAN/CANopen: send “18” to the special commands register (reg. 0x03).  

The fan will be back to in automatic control. 

7.7 Manually initiating a Safety run 

A safety run can be initiated manually either through CAN/CANopen command, or from the X4.  
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7.7.1 Prerequisites  

If in Normal operation state, the drive must be enabled. 

 

 

Note: Manual safety run can also be initiated while in states 3 (PwrOn @Parked), 4 (PwrOn not 
parked), or 5 (PwrOn not parked cold) where it only requires that the RUN input is high. 

7.7.2 Activation 

X4: Click on the “S-run” button in the quick access area. 

  

CAN/CANopen: send “1” to the “start safety run” register (Reg. 0x78) 

The IMD will change to state 19 (Safety run setup) and start a safety run. 

7.7.3 Operation 

N/A  

7.7.4 Deactivation 

Once initiated, a safety run cannot be deactivated. It stops only by activation of a limit switch, or 
timeout. 

 

 

7.8 Normal operation 

Normal operation is the state where the IMD controls the motor under normal conditions. 

7.8.1 Prerequisites  

The IMD must be in either Start up at park (3) or Parked ready (17) states.  

RFE and RUN inputs (X9, terminals 1 and 2) must be high. 

Safety chain inputs must be OK. 
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7.8.2 Activation 

X4: Click on the “Enable dev.” button: 

  

CAN/CANopen: changes the “Enable dev.” (reg. 0x51 bit 2) to “0” (on). 

7.8.3 Operation 

While in normal operation mode, is possible to disable and enable the drive by SW (reg. 0x51 bit 2), or 
HW (RUN input, X9-terminal 2). Both SW and HW must be enabled in order to enable the drive. 

When the drive is disabled, the output to the motor goes to zero, and the brake output is deactivated 
(+24 off). The “Dev. Enabled” and “GO” flags are set to zero. 

7.8.4 Deactivation 

Only errors and special commands will take the IMD out of the normal operation mode.  

7.9 Pre-heating the motor 

Activating the pre-heat function is done by using function 02 in the special functions. 

7.9.1 Prerequisites  

The Device must be disabled (reg. 0x51 bit 2 = 1). 

The IMD must be in one of the following states: 

• Normal operation (1) 

• PwrOn@Parked 

• PwrOn not Parked 

• Parked ready 

7.9.2 Activation 

X4: Select “2:Pre-heating” in the “States and special commands” in the “Monitor and control” tab. 

  

CAN/CANopen: send “2” to the special commands register (reg. 0x03) 

The IMD changes state to 32 – “Pre-heating on” and changes the “Dev. Enable” LED indication in the 
X4 to on. 
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7.9.3 Operation 

The IMD will remain in this state and pre-heat the motor until “0” (Idle) is sent to special commands 

register (reg. 0x03).  

If the “Enable dev.” button is changed to off, the IMD goes to state 42 (Pre-heating warning), and stays 
in this state until the heating is deactivated. While in this state, the heating cannot be activated again. 

7.9.4 Deactivation 

X4: Select “0:Idle” in the “States and special commands” in the “Monitor and control” tab. 

  

CAN/CANopen: send “0” to the special commands register (reg. 0x03). The IMD goes back to “Normal 

operation” state and the “Dev. enable” is changed to off. 

7.10 Safe energy (ultra-capacitors only) discharging 

It is possible to discharge ultra-capacitors for service purposes. Discharging is done using the ballast 
resistor to discharge the capacitors.  

7.10.1 Prerequisites 

The IMD must be in one of the following states: 

• SCR tripped (10) 

• Parked tripped (16) 

• Parked ready (17) 

• Safety run timeout (18) 

• Manual operation (59) 

7.10.2 Activation 

X4: Select “28:SE discharge ON” in the “States and special commands” group in the “Monitor and 
control” tab: 
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CAN/CANopen: send “28” to the special commands register (reg. 0x03). 

7.10.3 Operation 

When starting the discharge, the IMD disconnect the mains from the DC-link (“Mains, disconnect”), and 
turn the fan on. The discharge operation does not change the IMD state.  

The Actual SE voltage can be monitored continuously in the IMD manger: 

  

Discharging fully loaded capacitors can take some time. To calculate the approximate time full 
discharge will take use the following formula: 

Formula: 

𝑡 =
0.5∗𝐶∗𝑈2

𝑃𝑏∗0.75
       

t: Total approximate discharge time (to zero) in s 

C: Total SE capacity in F 

U: DC-link/SE voltage in V 

Pb: Ballast resistor rated power in W 

Example: 

𝑡 =
0.5∗2∗4502

300∗0.75 
= 900𝑠    

 

C: 2 F 

U: 450 V 

Pb: 300 W 

 

7.10.4 Deactivation 

X4: Select “29:SE discharge OFF” or “0: Idle” in the “States and special commands” group in the 
“Monitor and control” tab: 
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CAN/CANopen: send “29” to the special commands register (reg. 0x03). 

 

 The remaining voltage on the capacitors depends on the way the discharge stopped:  

• If the discharge is stopped due to missing 24 VDC, the remaining voltage across the ultra-
capacitors is approximately 100 V DC. 
 
NOTE   Mains voltage applied on the Mains input, ensures that the internal 24 V DC power supply 
             is functioning, even though the grid is off. 

• If the discharged is stopped by a command (“29:SE discharge OFF” or “0: Idle”), the remaining 
voltage across the ultra-capacitors depends on the capacity and charge level of the ultra-capacitors, 
discharge time, and the ballast resistor. 

 

NOTE  After deactivation the grid remains disconnected. 

7.11 Tripping safety-chain outputs 

It is possible to trip the safety-chain outputs (SCR1 and SCR 2) manually, which can be used for 
example to trip the safety chain relay.  

7.11.1 Prerequisites  

There must be no active errors. 
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7.11.2 Activation 

X4: Select “14:Trip SCR output” in the “States and special commands” in the “Monitor and control” tab. 

  

CAN/CANopen: send “14” to the special commands register (reg. 0x03) 

The IMD will trip SCR 1 and SCR 2, and depending on the state it is in, change the state. 

7.11.3 Operation 

N/A  

7.11.4 Deactivation 

N/A 

7.12 Turning the power to the IMD on 

Ensure that all connections to the IMD are made. 

 

1. Switch the supply to X1.MAINS on 

2. If there is a separate supply to X7.24V switch it on (can also be turned on at the same time as 
Mains supply) 

3. Switch the supply to X1.SAFE ENERGY on 

7.13 Updating Firmware 

There are two ways to update the firmware (FW) of the IMD: 

1. Update through the “Service” USB connector: mainly used in production, service and lab. 

2. Update through CANopen: mainly used in cases when updating remotely, thus eliminating the 
need for physical presence in the hub. 

When updating through the Service USB connector, an internal bootloader initiated by setting the CAN 
ID switch to 15 and restarting the IMD is used to load the new firmware. 

 

Attention 

If the safe energy was disconnected from the SE terminals, the mains supply must be 
turned on before the safe energy is turned on. 
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When updating through CANopen, a special bootloader must be loaded first through the Service 
connector (one time only), and is initiated when needed by a CANopen command. 
Using CANopen update method requires development and implementation (by the customer) of update 
SW in the Pitch Motion Controller or the turbine’s Main Controller. 

It is also possible to load both CANopen bootloader and FW through the Service USB connector (the 
IMD is then prepared for FW update through CANopen in the future). 

The full FW package contains different files which are used depending on the update method chosen 
(the bootloader will typically be released in a separated release package): 

Table 5 FW packages and installation methods 

Installation method Files Description 

“Service” USB 
connector 

• IMD.out Only FW application is installed. Internal built-
in bootloader is used for the installation.  

Programming mode (built-in bootloader) is 
initiated by setting CAN ID to 15 and 
restarting the IMD.  
 

NOTE  If the IMD.out file is installed after 

the CANopen bootloader is installed, 
the bootloader will be erased and 
overwritten.  

CANopen • IMD_Bootloader.out 

• CoU_IMD.crc 

In the first time, the bootloader 
(IMD_Bootloader.out) is installed through 

the “Service” USB connector, followed by FW 
application (CoU_IMD.crc ) installation 

through CANopen. In later updates only the 
FW application is installed through CANopen, 
using the already installed bootloader. 

The bootloader is initiated by a CAN 
command. 

CANopen files 
through USB 
“service” connector 

• IMD_Bootloader.out 

• CoU_IMD.out 

This is an installation of CANopen files 
installed through the “Service” USB 
connector. It can be used to prepare the IMD 
for later CANopen FW updates.  

Programming mode (built-in bootloader) is 
initiated by setting CAN ID to 15 and 
restarting the IMD. 

 

7.13.1 Updating firmware with the Service USB connector method 

7.13.1.1 Prerequisites 

• A computer with Spectrum Digital SDFlash program installed (including V3.3 SDFlash serial patch 
for flash programming, September 5, 2008), (http://emulators.spectrumdigital.com/utilities/sdflash/) 

Typically, the necessary USB driver will be found automatically if the computer is on-line. Otherwise, 
go to Silicon Labs home page and download the latest driver for CP210x USB to UART Bridge 
(http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx). 
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• The computer must be connected to the IMD with USB cable (male type A to male type B). 

• Prepare the FW files for use: 

1. Copy the folder of the new FW. 

2. Paste the folder in the folder where other FW is located.  
If the FW files are located at their default location, go to myprojects folder in sdflash folder 

(where sdflash was installed) and paste the folder under myprojects. 

NOTE  The files can be located anywhere. It is possible to brows to the location and sdflash 
             remembers this location. 

3. Copy any of the .sdp files in the folder and paste it (the .sdp).  

4. Rename the .sdp file to the same name as the new FW folder: 

 

 

7.13.1.2 Updating firmware – USB FW 

1. Before turning the power to the IMD ON (24 V DC if the IMD does not have built-in power supply, or 
400 V AC if it does have a built-in power supply), ensure that the RFE input is OFF to prevent the 
IMD from starting the motor unintentionally. 

2. Start the SDFlash if it is not started already. 

3. Set the IMD into programming mode by doing the following: 

a. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) off.  

b. Set the CAN ID switch to position 15. 

c. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) on. 

 

Info 

The links above were valid at the time when this manual was written. If the link does 
not work anymore, search for  “V3.3 SDFlash serial patch” or “CP210x USB 

to UART Bridge driver”. 
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4. Click File→Open Project… (1), select and select the .sdp file that belongs to the FW that should be 
installed (2) and click Open (3):

 

 
 

5. Skip this step if the used Com port is known. 
Open the “Device manager” in the computer’s “Settings” and determine which com port is used for 
the USB connection (the look and name of the device manager may differ depending on the 
operating system). Only Com1, Com2, Com3, and Com4 can be used with the SDFlash, if another 
port is selected by the system, you will need to change it so one of the mentioned ports is used:  

 

 

1 

2 

3 
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6. Click on Project →Settings… to open the Settings dialogue. Select the same com port as used in 
the device manager (COM1 → C1):  

 

 

7. Click on the “Erase” tab (1), and ensure that “User Options 1:” is set to “00ff” (2): 

 

 
 

8. Click on the “Programming” tab (1), then on the … button of the Flash Data File (2), double click on 
the FW folder (3), select the IMD.out file and click Open (4): 

2 

1 
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9. Click OK. 

 

 

Info 

If the com port or user option 1 was changed, you will be asked to save you 
project settings first, when attempting to upgrade the firmware in an IMD. 

2 

1 

3 

4 
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10. Click on Device → Flash… to open the upgrade dialogue: 

 

11. Ensure that all three checkboxes are ticked and click Start. 

12. When the programming cycle is completed, set the IMD back to normal operation mode: 

a. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) off.  

b. Set the CAN ID switch back to its original position. 

c. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) on. Note that the first 
startup after firmware upgrade might take longer (up to approximately 10 s).  

13. The IMD is now updated. 

7.13.2 Updating firmware with CANopen files using service USB connector method 

Updating firmware with CANopen files, requires that a bootloader is installed as well. Once the 
bootloader is installed (see section 7.13.2.2 on page 49 ), it is enough to install only the FW file (see 
section 7.13.2.3 on page 54 or section 7.13.3 on page 58 depending on the method).  

7.13.2.1 Prerequisites 

• A computer with Spectrum Digital SDFlash program installed (including V3.3 SDFlash serial patch 
for flash programming, September 5, 2008), (http://emulators.spectrumdigital.com/utilities/sdflash/) 

Typically, the necessary USB driver will be found automatically if the computer is on-line. Otherwise, 
go to Silicon Labs home page and download the latest driver for CP210x USB to UART Bridge 
(http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx). 

• The computer must be connected to the IMD with USB cable (male type A to male type B). 

 

Info 

On rare occasions, The SDFlash program will show a “Connection error” after step 11 on 
page 48 is executed. In such a case, it is necessary to restart the whole process: 

1. Close the SDflash program 

2. Turn off the IMD 

3. Start the SDflash 

4. Turn on the IMD 

5. Repeat com configuration, and the actions described in steps 4 on page 45 to 13 on 
page 48 . 

 

Info 

The links above were valid at the time when this manual was written. If the link does 
not work anymore, search for  “V3.3 SDFlash serial patch” or “CP210x USB to 
UART Bridge driver”. 
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• Prepare the FW files for use.  

1. Copy the folder of the new FW. 

2. Paste the folder in the folder where other FW is located. If the FW files are located at their 
default location, go to myprojects folder in sdflash folder (where sdflash was installed) and 

paste the folder under myprojects. 

NOTE  The files can be located anywhere. It is possible to brows to the location and sdflash 
             remembers this location. 

3. Copy any of the .sdp files in the folder and paste it.  

4. Rename the .sdp file to the same name as the new FW folder: 

 

5. If there is no bootloader package in the folder, repeat the previous steps (1 to 4) for the 
bootloader: 

 

 

7.13.2.2 Updating CANopen bootloader file 

This task needs only to be done once, unless a newer bootloader version than the one already installed 
is available. 

1. Before turning the power to the IMD ON (24 V DC if the IMD does not have built-in power supply, or 
400 V AC if it does have a built-in power supply), ensure that the RFE input is OFF to prevent the 
IMD from starting the motor unintentionally. 

2. Connect the computer to the IMD Service connector with USB cable (male type A to male type B). 

3. Start the SDFlash if it is not started already. 
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4. Click File→Open Project… (1), select and select the .sdp file that belongs to the bootloader 
package that should be installed (2), and click Open (3):

 

 
 

5. Skip this step if the used Com port is known. 
Open the “Device manager” in the computer’s “Settings” and determine which com port is used for 
the USB connection (the look and name of the device manager may differ depending on the 
operating system). Only Com1, Com2, Com3, and Com4 can be used with the SDFlash, if another 
port is selected by the system, you will need to change it so one of the mentioned ports is used:  

 

 

1 

2 

3 

http://www.deifwindpower.com/


IMD 100 Service and maintenance manual 4189360017 Rev. E  Operational procedures (how to)  

 

www.deifwindpower.com Page 51 of 81 

6. Click on Project →Settings… to open the Settings dialogue. Select the same com port as used in 
the device manager (COM1 → C1):  

 

 

7. Click on Project →Settings… to open the Settings dialogue. 
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8. Click on the “Erase” tab (1), and ensure that “User Options 1:” is set to “0001” (2): 

 

 

NOTE  This step ensures that only the space allocated for the bootloader will be erased. 

2 

1 
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9. Click on the “Programming” tab (1), then on the … button of the Flash Data File (2), double click on 
the bootloader folder (3), select the IMD_bootloader.out file and click Open (4): 

 
 
 

10. Click OK. 

 

11. Set the IMD into programming mode by doing the following: 

a. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) off.  

b. Set the CAN ID switch to position 15. 

c. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) on. 

12. Click on Device → Flash… to open the upgrade dialogue: 

 

Info 

If the com port or user option 1 was changed, you will be asked to save you project 
settings first, when attempting to update the bootloader in an IMD. 

2 

1 

3 
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13. Ensure that all three checkboxes are ticked and click Start.  

14. When the programming cycle is completed, click Close. 

15. Skip this step if the FW is to be update as well.  
Set the IMD back to normal operation mode: 

a. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) off.  

b. Set the CAN ID switch back to its original position. 

c. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) on. Note that the first 
startup after firmware upgrade might take longer (up to approximately 10 s).  

16. The IMD is now updated. 

7.13.2.3 Updating CANopen FW file 

This procedure describes how to update the IMD FW in an IMD prepared for CANopen FW update, 
through the Service USB connector. 

1. Skip this step if the SDFlash is started, and IMD is already turned on in programming mode  

a. Before turning the power to the IMD ON (24 V DC if the IMD does not have built-in power 
supply, or 400 V AC if it does have a built-in power supply), ensure that the RFE input is OFF to 
prevent the IMD from starting the motor unintentionally. 

b. Start the SDFlash if it is not started already. 

c. Set the IMD into programming mode by doing the following: 

i. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) off.  

ii. Set the CAN ID switch to position 15. 

iii. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) on. 

 

Info 

On rare occasions, The SDflash program will show a “Connection error” after step 11 on 
page 48 is executed. In such a case, it is necessary to restart the whole process: 

6. Close the SDflash program 

7. Turn off the IMD 

8. Start the SDflash 

9. Turn on the IMD 

10. Repeat com configuration, and the actions described in steps 4 on page 45 to 13 on 
page 48 . 
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2. Click File→Open Project… (1), select and select the .sdp file that belongs to the FW that should be 
installed (2) and click Open (3):

 

 
 

3. Skip this step if the used Com port is known. 
Open the “Device manager” in the computer’s “Settings” and determine which com port is used for 
the USB connection (the look and name of the device manager may differ depending on the 
operating system). Only Com1, Com2, Com3, and Com4 can be used with the SDFlash, if another 
port is selected by the system, you will need to change it so one of the mentioned ports is used:  

 

 

1 

2 

3 
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4. Click on Project →Settings… to open the Settings dialogue. Select the same com port as used in 
the device manager (COM1 → C1):  

 

 

5. Click on the “Erase” tab (1), and ensure that “User Options 1:” is set to “00fe” (2): 

 

 

NOTE  This step ensures that the bootloader already installed will not erased. 
 

6. Click on the “Programming” tab (1), then on the … button of the Flash Data File (2), double click on 
the FW folder (3), select the CoU_IMD.out file and click Open (4): 

2 

1 
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7. Click OK. 

 

 

Info 

If the com port or user option 1 was changed, you will be asked to save you 
project settings first, when attempting to upgrade the firmware in an IMD. 

2 

1 

3 

4 
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8. Click on Device → Flash… to open the upgrade dialogue: 

 

9. Ensure that all three checkboxes are ticked and click Start. 

10. When the programming cycle is completed, set the IMD back to normal operation mode: 

a. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) off.  

b. Set the CAN ID switch back to its original position. 

c. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) on. Note that the first 
startup after firmware upgrade might take longer (up to approximately 10 s).  

11. The IMD is now updated. 

 

 

7.13.3 Updating firmware through CANopen 

7.13.3.1 Prerequisites 

• A specific “FW updater” SW must be implemented (by the customer) in the Pitch Motion Controller, 
or Turbine Controller. 

• Instructions on how to use the implemented “FW updater” SW available 

• Bootloader for CANopen FW update is installed on the IMD (see section 7.13.2.2 on page 49)  

• The turbine must be stopped in a safe position and all blades are in fully feathered position. 

7.13.3.2 Updating the firmware 

1. Update the firmware according the “FW updater” instructions 

2. When all IMDs are updated the turbine can be restarted 

 

Info 

On rare occasions, The SDFlash program will show a “Connection error” after step 11 on 
page 48 is executed. In such a case, it is necessary to restart the whole process: 

11. Close the SDflash program 

12. Turn off the IMD 

13. Start the SDflash 

14. Turn on the IMD 

15. Repeat com configuration, and the actions described in steps 4 on page 45 to 13 on 
page 48 . 
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7.14 Using digital inputs and outputs 

The digital inputs and outputs are not dependent on the state of the IMD. It is possible to read the state 
of a digital input or output, as well as set or reset a digital output no matter which operational state the 
IMD is in. Digital outputs D5 to D8 as well as digital inputs 1 and 2 can be also be controlled by 
mapping (assigning) logical function to them. When this is done, an output will change state or a 
function will be activated/deactivated when an input change state. See the description of how to use in 
the IMD manager user manual. 

7.14.1 Digital outputs 

This section describes how to use the digital outputs. 

7.14.1.1 Prerequisites 

None 

7.14.1.2 Activation 

X4: Click on the “DO x” button of the digital output to toggle it: 

 

 

CAN/CANopen: Set the applicable bit in Reg. 0x98 (see IMD 100 integration manual for bit mapping) 
to “1” (on). 

7.14.1.3 Operation 

X4: The state of all digital outputs is represented by LED in the “Monitor and control” tab. The LED is 
turned ON when the output is ON, and Off when the output is Off. 

CAN/CANopen: The state of all digital inputs can be retrieved from object 2098 (see IMD 100 
integration manual for bit mapping).  
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7.14.1.4 Deactivation 

X4: Click on the “DO x” button of the digital output to toggle it: 

 

CAN/CANopen: Reset the applicable bit in object 2098 (see IMD 100 integration manual for bit 
mapping) to “0” (Off). 

7.14.2 Digital inputs 

This section describes how to use the digital inputs. 

7.14.2.1 Prerequisites 

None 

7.14.2.2 Activation 

None 

7.14.2.3 Operation 

X4: The state of all digital inputs is represented by LED in the “Monitor and control” tab. The LED is 
turned ON when the input is high, and Off when the input is low. 
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CAN/CANopen: The state of all digital inputs can be retrieved from object 209B (see IMD 100 
integration manual for bit mapping).  

7.14.2.4 Deactivation 

None. 

7.15 Retrieving error additional information (error snapshot) 

The error snapshot function records additional information about the conditions just before the last error 
occurred. The records are saved in the RAM of the IMD as an oscilloscope capture. However, it is not 
possible to view the records in the IMD manager oscilloscope. The parameter set for recording is 
chosen to provide maximum of information in the event of a fault, and cannot be changed. 

The settings of the built-in oscilloscope are automatically set when the IMD starts. A capture is made in 
the event of every error except for RFE missing. The recorded information always start before the error 
event, in order to have information about the conditions leading to the error. If the oscilloscope is used 
through the IMD manager, these settings are overwritten and the snapshot function is disabled, until the 
IMD restarts. 

When an error occurs, the IMD saves the information in the RAM. The recorded information must be 
exported manually. If the oscilloscope is used before the snapshot information is exported, the 
information is lost. 

The data is recorded as raw data of the registers. Some data is given as hexadecimal (indicated with 
0x), and some as decimal. The exported information is exported in two files: 

• A .csv file containing all the recorded error history information as well as the capture information  

• A .txt file containing the oscilloscope settings and capture 

7.15.1 Prerequisites 

• The IMD FW is 1-08-9 or later 

• The oscilloscope was not used since the IMD started 

• IMD manager is available, to be able to export the information 

7.15.2 Activation 

The activation of the error snapshot is automatic, whenever an error occurs except for RFE missing 
(error 2). 
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7.15.3 Operation 

3. After the error, export the data by clicking in the icon in the Error history tab of the IMD manager (1): 

 

The icon changes to  and the “Error no. in log” counts up through all the recorded errors in the 
error history. This may take some time.  

When the icon changes back to , the two files are saved in C:\IMD-error-snapshot folder: 

 

Each file name contains a date and time stamp, and contains the parameters values, and all data 
from all errors in the Error history log. 

4. The data can be processed with any tool available. 

7.15.4 Deactivation 

The snapshot function is deactivated if the oscilloscope in the IMD manager is used. 

1 
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8. Storage 

Handle the IMD as any electronic equipment. 

 

IMD storage requirements: 

Temperature -40...85 °C IEC 60068-2-1/2, IEC/EN 61800-5-1 

Humidity  95% non-condensing IEC/EN 61800-5-1 
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9. Quick temperature conversion charts  

9.1 Motor temperature 
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9.2 Pt1 to Pt4 (Pt100 sensors) 
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10. IMD display description 

The IMD display indicates the status of the IMD. The display contains a seven-segment display and a 
multicolour LED. Interpretation of the information is a combination of both display and LED. 

NOTE   In boot mode (firmware upgrade) the display and LED state are totally random, and may even 
be turned off. This is normal behaviour and does not indicate any error or faulty condition. 

10.1 Status LED 

The LED on the front panel of the IMD indicates the status of errors, warnings and safety chain inputs, 

 

 

Table 6 Status LED states 

LED state Active error Active warning Safety chain inputs 

Off None None Not OK 

Green continuous None None OK 

Orange*/green flashing alternately 

The display alternates between warning 
and operational state: 
Orange (1/4 of cycle): the display shows 
warning number 

Green (3/4 of cycle): the display shows 
operational state 

None Active warning. 

Display shows 

warning no. 

OK 

Red flashing None Active warning. 

Display shows 

warning no 

Not OK 

Red continuous Active error. 
Display shows 
error no. 

Don’t care Not OK 

Orange* continuous Active error. 
Display shows 
error no. 

Don’t care OK 

* Orange may look like red or yellow depending on the angle of viewing. 
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10.2 MODE seven segment display 

 

The seven-segment display shows the state of the IMD as well as which error or warning are active. 
See Status LED states table on page 66  for information about the relations between the LED and 
display. 

10.2.1 The seven-segment display in normal state operation 

The following table shows how to interpret the display information for normal state (LED green or off 
while flashing): 

Table 7 Display of operational state 

MODE 
display 

Dot / Line Description 

 

Flashing 

Off 

Normal operation – IMD is active. 

IMD is not operating. Missing Voltage or hardware failure 

 

Flashing 

On 

Off 

The IMD is starting after a reset. 

Drive enabled 

Drive is disabled 

 

on The IMD is holding the blade motor in position (speed is zero) 

 

on The drive is turning in positive direction 

 

on The drive is turning in negative direction 

 

Flashing 

On 

Off 

The current is limited to I-nom 

The current is limited to I-max 

Normal operation, the current is equal to or bellow I-nom 

 

On for  
0.1 s 

A new command was received through the CAN bus or the USB. 

 

The display will show any combination of the operational states. For example, when the motor turns in 
the positive direction: 

Example: 

 

 

Normal operation – IMD is active (dot flashing). 
The drive is enabled (Bottom line on) 
The motor is now turning in positive direction (right lower line) 
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10.2.2 The seven-segment display when a warning is active 

When a warning is active the display switches between showing the warning number/letter as described 
in the Warning list and description table on page 72 (when the LED is flashing orange and in on state), 
and the operational state as described in the Display of operational state table on page 67 (when the 
LED is in off state). The dot will be flashing as well.  

The LED and display cycle is as follows: 

Dot Status LED 7 Segment display 

ON Orange Warning number 

OFF Green Operational state number 

ON Green Operational state number 

OFF Green Operational state number 

10.2.3 The seven-segment display when an error is active 

When an error is active the display shows the error number/letter as described in the Error list and 
description table on page 69. The dot will be flashing as well. 
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11. Errors and warnings 

The IMD has two ways to report faults: Errors and warnings: 

 Cause and action Reset 

Warning Normal parameter limits are 
beginning to be crossed. No 
immediate action.  

If not addressed, some warnings 
might escalate to errors after a 
timeout. 

Automatically reset when the cause is removed. 

Error Severe violation of limits, causing 
a safety chain trip, and either an 
immediate motor stop or initiating 
a safety run. 

Reset is done either from the controller, another USB 
device, or using the IMD Manager tool.  

From the application SW or another USB device, 
writing any value to register 0x8E resets errors. 

Reset is not possible if the cause is not removed. 

Both errors and warnings are displayed on the IMD display and the IMD Manager tool. 

11.1 Error list 

When an error is active it is displayed in the IMD Manager tool in the “Error(s)” field. Following is a list 
of errors:  

Table 8 Error list and description 

IMD 
display 
/ Error 
bit no. 

IMD Manager 
Error(s) field 

Safety run 
performed 

Error description 

0 BADPARAS No 
Checksum (CRC) error when reading parameters from 
EEPROM. This error can only be reset by a power-
cycle (OFF-ON) of the IMD. 

1 POWER FAULT No 
A fault condition related to the IGBT module is 
detected.  

2 RFE open No RFE (Rotational Field Enable) input is in low state.  

3 BUS TIMEOUT Yes 

This error can be caused by three reasons: 

• Timeout has occurred on the CAN-bus. Timeout 
period defined in ms in register CAN_TIMEOUT 
(0xd0). The bus time out error is enabled after the 
CAN bus has reached operational state. 

• Communication error with the built-in charger (after 
the communication was initialised at start-up). 

• Communication error with the built-in charger 
(option). When resulting from this reason, the error 
is generated automatically after warning 3 has been 
active during the Charger timeout period and not 
cleared.  

4 FEEDBACK Yes 
Bad or no motor feedback signal. The resolver circuit 
detects a fault.  
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IMD 
display 
/ Error 
bit no. 

IMD Manager 
Error(s) field 

Safety run 
performed 

Error description 

5 UNDERVOLTAGE No 
DC link voltage is lower than DC-link Vlow or DC-link 
Vmin.  

6 MOTORTEMP Yes 

Motor temperature too high. Motor-temperature reached 
the limit specified in M-temp.  
This error can be reset after the motor had cooled 
down. 

7 DEVICETEMP Yes 
IMD temperature too high.  
This error can be reset after the IMD had cooled down. 

8 OVERVOLTAGE Yes/No 
DC-link voltage upper limits (HW DC-link overvoltage or 
DC-link Vmax) exceeded.  

9 I_PEAK No 
The current to the motor exceeded the peak current 
limit for more than 8 ms.  

A MOTOR OUTPUT No 

The motor speed and direction cannot be controlled. 
The motor either races at full speed or cannot move. 
This error can be caused by four reasons: 

• Non coherent parameter configuration. 

• Mismatch between the direction from the drive and 
direction from the motor feedback. 

• The phase sequence (W, V, U) is wrong. 

• At least one of the phases from the IMD to the 
motor is disconnected. 

B CHARGER  

Error in the charger (option). This error is generated 
automatically after warning B has been active during 
the Charger timeout period and not cleared. 

There are a number of charger errors that caused the 
warning that was escalated to the error. Possible errors 
are listed in section 11.1.1 on page 71. The active 
errors can be determined by reading the charger error 
register. 

C HIGHVOLTAGE Yes 
HIGHVOLTAGE warning was on more than 
approximately five seconds. 

D PRE_CHARGE Yes 
Pre-charge circuit failure. Mains power cannot be 
connected to DC link. 
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IMD 
display 
/ Error 
bit no. 

IMD Manager 
Error(s) field 

Safety run 
performed 

Error description 

E HW-ERROR 

No 

Hardware component failure. Multiple reasons can 
cause this error. For example: 

• An internal supply voltage has failed 

• Internal communication to power-module has timed 
out 

• The controller has detected a power-module error-
condition 

• The internal current measurement has failed 

Determination of the precise reason can only be done 
by experts, possibly also using the errors log. 

 

F 
BALLAST Yes 

This error can be caused by two reasons: 

• Ballast resistor overload. The ballast resistor load 
has exceeded the configured value (Ballast-P). This 
error can be reset after a timeout has elapsed. 

• Hardware failure in the ballast circuit or resistor 

11.1.1 Charger (option) errors 

If the built-in charger option is mounted in the IMD, the following errors can be read from the charger 
warnings register: 

Error 
bit no. 

Error text Error description 

0 OPENCIRCUIT 
The charger detected open circuit. No safe energy source is 
connected, or a wire is broken. 

1 SHORTCIRCUIT 

The SE output is short-circuited.  

For lead acid this error is raised when the SE voltage is less than 
20% of nominal while charging. 

2 CHARGERTEMP The internal temperature of the charger is too high. 
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11.2 Warning list 

When a warning is active it is displayed in the IMD Manager tool in the “Warning(s)” field. Following is a 
list of warnings:  

Table 9 Warning list and description 

Warning 
bit no. 

IMD Manager 
Warning(s) field 

Warning description 

0 BADPARA 

Parameter error. This warning can be caused by the following 
reasons: 

• Deceleration ramp too long when “Run” signal is deactivated 

• Calculation of motor-parameters gives an unlikely result 

1 Warning 1 Not used 

2 Warning 2 Not used 

3 COMCHARGER 

Communication error with the built-in charger (option).  

If this warning persists for the Charger timeout period, and the IMD 
is configured to escalate charger warnings to error, error 3 will be 
generated. 

Sending “clear errors” every 8 seconds will delay error generation 
(until clearing errors is stopped) if the warning persists. 

4 FEEDBACK 
Unstable resolver signal. This warning is also active during blind 
safety run. 

5 POWERVOLTAGE Safe energy voltage is lower than SE Vmin. 

6 MOTORTEMP 
--Motor temperature high. Motor-temperature reached 87.5% of the 
limit specified in M-temp. 

7 DEVICETEMP 
IMD temperature high.  
Internal components temperature exceeded 72 ºC.  

8 Warning 8 Not used 

9 I_PEAK Digital output driver is overheated 

A Warning A Not used 

B CHARGER 

Error in the charger (option).  

There are a number of charger errors that caused the warning that 
was escalated to the error. These can be determined by reading the 
charger error register. 

If this warning persists for the Charger timeout period, and the IMD 
is configured to escalate charger warnings to error, error 3 will be 
generated. 

Sending “clear errors” every 8 seconds will delay error generation 
(until clearing errors is stopped) if the warning persists. 

C HIGHVOLTAGE 
Ballast resistor is on too long (> 100 ms) while the Mains is ON. If 
the pitch controller does not act for more than 5 seconds, a 
HIGHVOLTAGE error is generated, and the warning is reset. 

D Warning D Not used 

http://www.deifwindpower.com/


IMD 100 Service and maintenance manual 4189360017 Rev. E  IMD display description  

 

www.deifwindpower.com Page 73 of 81 

Warning 
bit no. 

IMD Manager 
Warning(s) field 

Warning description 

E HW-warning 

This warning can be caused by the following reasons: 

• Current offset too high (too far from zero) 

• Pt100 measurements are wrong, measured value cannot be 
trusted 

• DI 10, 11 or 12 is high when not in manual operation mode (and 
manual mode is enabled). 

F BALLAST 
The ballast resistor load is over 50% the configured maximum 
value.  

11.2.1 Charger (option) warnings  

If the built-in charger option is mounted in the IMD, the following warnings can be read from the charger 
warnings register: 

Warning 
bit no. 

Warning text Description 

0 BATTEMP 
The battery temperature is more than 10ºC outside charging 
temperature limits (-20ºC to 50ºC). Lead acid only. 

1 TEMPCHANNEL The defined temperature sensor channel is not valid. 

2 VinLOW The input voltage from the DC-link is below 270 V DC. 

3 Vin-VseLOW 
The input voltage from the DC-link is not at least 15 V DC higher 
than the SE voltage. 

4 LOWCURR. The output current is too low compared to setpoint. 

 

11.3 Errors log 

The IMD has an error log containing up to 20 entries. The log is a rolling log using “First In First Out” 
principle, which means that it always contain the latest 20 errors generated by the IMD, with the latest 
error at the top. The log entries are available in the IMD Manager and through CAN/CANopen. Each 
entry contains the following parameter values at the time the error occurred (see description of the 
register in the Integration manual for details): 

Information Register Description 

IMD state 0x02 The state of the IMD  

T-IGBT 0x4A The numeric representation of the IGBT temperature 

N act (filt) 0xA8 The filtered actual speed value in units 

N cmd ramp  0x32 Speed command after ramp in units 

I act (filt) 0x5F Actual filtered current value in units 

DC-link 
voltage 

0xEB The filtered voltage of the DC-link in units 

Drive status 0x40 Bit map representation of the state of the internal flags 
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Information Register Description 

Logic in 
block 

0x9B Bit map representation of the state of digital inputs and some 
internal flags 

Out block 0x98 Bit map representation of the state of digital outputs 

Power 
board 
status 

0x63 Status of the power board 

Actual 
current limit 

0x48 The current limit used at the time 

Special 
command 

0x03 The values of the special commands register. If a command was 
executed, the register contains the feedback for the command. 

Error 
register 
value 

0x8F Active errors at the time the error occurred 

ID N/A Special ID information for the error 

Timestamp 
1 (Device 
enabled) 

N/A A relative time stamp (seconds) for the entry indicating the time 

elapsed since the last time the device enabled flag was set 

Timestamp 
2 (power) 

N/A A relative time stamp (seconds) for the entry indicating the time 

elapsed since the last power on of the IMD 

Timestamp 
3 (life) 

N/A A relative time stamp (seconds) for the entry indicating the time 
elapsed since the IMD was delivered from the factory, or if the 
IMD is older, since the first time a firmware supporting error 
history was installed. This time counter only counts time when the 
IMD 24 V DC supply (external or internal) is on. 

For IMDs that were delivered with FW older than 1-08-0 (first FW 
with error log) the life time stamp is relative to the time when the 
first FW supporting error log was installed on the IMD. 

 

The last error further contains the following parameter values at the time the error occurred (Extra info):  

Information Register Description 

Actual 
position 

0x6D The actual position based on the resolver and rounds count 

Actual 
position SSI 

0x6F The actual position based on the SSI encoder count 

1st error in 
power 
board 

0x94 First error (code) on power board since last clear error command. 

Ballast 
energy 
counter (L) 
and Current 
overload 
integral (H) 

0x45 Values of Ballast energy counter (low 16 bits), Current overload 
integral (High16 bits),  

SE voltage 0x66 Numeric value of the safe energy voltage 
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Information Register Description 

SE mid-
point 
voltage 

0x61 Numeric value of the safe energy mid-point voltage 

T-air 0x4B Numeric value of the air temperature inside the IMD 

(dbg) *temp 0x9A Dynamic pointer register used for debug by DEIF engineers 

(dbg) *ptr1 0xB8 Dynamic pointer register used for debug by DEIF engineers 

(dbg) *ptr2 0xBA Dynamic pointer register used for debug by DEIF engineers 

(dbg)  ptr1 0xB7 Dynamic pointer register used for debug by DEIF engineers 

(dbg)  ptr2 0xB9 Dynamic pointer register used for debug by DEIF engineers 

 

The error log also contains a distribution representation of all errors occurred during the “Elapsed 
time:life” (the time elapsed since the first FW supporting error history was installed), showing how many 
times each error appears in the log:  
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12. Troubleshooting 

See troubleshooting in the IMD 100 initial configuration and verification manual (4189360016). 

 

13. Disposal of the IMD 

 

 

All products that are marked with the crossed-out wheeled bin (the WEEE symbol) 
are electrical and electronic equipment (EEE). EEE contains materials, components 
and substances that can be dangerous and harmful to people's health and to the 
environment. Waste electrical and electronic equipment (WEEE) must therefore be 
disposed of properly. In Europe, the disposal of WEEE is governed by the WEEE 
directive issued by the European Parliament. DEIF complies with this directive. 

You must not dispose of WEEE as unsorted municipal waste. Instead, WEEE must 
be collected separately, to minimise the load on the environment, and to improve the 
opportunities to recycle, reuse and/or recover the WEEE. In Europe, local 
governments are responsible for facilities to receive WEEE. If you need more 
information on how to dispose of DEIF WEEE, please contact DEIF. 
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14. Revision history 

Apart from editorial changes the following changes have been made in this revision: 

Date Revision Changes 

2021-01-29 E • “Manual operation and function verification” renamed to 
“Operational procedures (how to)” 

• “Operational procedures (how to)” updated with: 

- General information regarding power supply 

- Safety information 

- New operational procedures (copied from “IMD 100 
Integration manual”) 

• IMD 135 added to “Checking electrical connections” 

• “Replacing IMD 135 C fan” added in “Replacing the fan" 

2020-09-25 D • “Connecting the safe energy” in “Avoiding damage to the 
IMD” updated 

• “Charger (option) warning” in “Warning list” updated 

2020-06-29 C • “IMD maintenance schedule” section added. 

• “Disclaimer” and “Introduction” updated 

• “Replacing the fan” structure changed (two types of fan). 
“Replacing IMD 122 C type fan” added.  

• “Checking corrosion” section added in “Preventive 
maintenance of the IMD” 

• Referenced documents section added 

• Note added when describing the fan cover to allow for 
different cover 

• “Manual operation and “function verification” section added 

• Checking electrical connections updated with IMD 122C 

• Errors and warnings updated 

• “Disposal of the IMD” section added 

• “Error and warning lists” section renamed to “Errors and 
warnings” 

• “Errors and warnings log” section added to “Errors and 
warnings” section 

2018-04-19 B Description of LED display, errors and warnings updated. 

2017-03-03 A This is the first version of the document. 
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15. Product user documentation 

The IMD product has an extensive user documentation, targeted towards different audience and 
product use stages.  

The following documents are part of the user documentation:  

Table 10 IMD user documentation 

Document Target audience Content 

IMD 100 datasheet 

Document no.: 
4921260015 

Buyers and technicians 
of customers 

Describes relevant specifications and give an 
overview of the IMD functions 

IMD 100 function 
description 

Document no.: 
4189360013  

Mainly technicians and 
engineers of customers. 

Describes the functions of the IMD. Gives the 
reader an understanding of the purpose of the IMD 
in a system, and which functions can be utilised in 
a pitch system. The functions are described so that 
the reader can understand what each function is 
used for. 

IMD 100 
integration manual  

Document no.: 
4189360015 

Engineers at customer 
R&D department 

Describes how to integrate the IMD in a pitch 
system. Gives extensive knowledge about: 

IMD SW (parameters and how to achieve specific 
functionality) 

How to create customized parameter file for use in 
production 

Requirements for external interfaces/components 

IMD Manager 
installation 
instructions 
Document no.: 
4189360018 

Engineers at customer 
R&D department, as well 
as commissioners and 
service personnel 

Describes how to install the IMD Manager.  
The IMD Manager is an application used to 
configure and control the IMD using the Service 
USB connector. 

IMD Manager user 
manual  

Document no.: 
4189360019 

Engineers at customer 
R&D department, as well 
as commissioners and 
service personnel 

Describes how to use the IMD Manager.  
The IMD Manager is an application used to 
configure and control the IMD using the Service 
USB connector. 

IMD 100 
installation 
instructions 
Document no.: 
4189360005 

Technicians at 
production site where the 
IMD is mounted in the 
cabinet/hub 

Describes how to mount, connect and perform 
initial start, test, and configuration (using a 
configuration file) of the IMD at production. 

IMD 100 initial 
configuration and 
verification manual 

Document no.: 
4189360016 

Commissioners or other 
personnel with similar 
qualifications, as well as 
service personnel (for 
SW upgrade) 

Describes how to upgrade the IMD SW, how to 
load configuration file, and how to verify the IMD 
installation to the possible extent. 

IMD 100 service 
and maintenance 
manual 

Document no.: 
4189360017 

Service and warehouse 
personnel 

Describes preventive (scheduled) and corrective 
maintenance of the IMD, as well as storage 
requirements. 
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Document Target audience Content 

IMD 100 
installation 
checklist 

Document no.: 
4189360021 

Technicians at 
production site where the 
IMD is mounted in the 
cabinet/hub 

Installation tasks with check boxes to document the 
tasks done during installation 

IMD 100 
configuration and 
verification 
checklist 

Document no.: 
4189360022 

Commissioners or other 
personnel with similar 
qualifications, as well as 
service personnel (for 
SW upgrade) 

configuration and verification tasks with check 
boxes to document the tasks done during 
configuration and verification 

Addendum to 
installation manual 

Document no.: 
4189360023 

Integration and 
installation personnel 

Describes the how to replace a pitch drive when 
the IMD is equipped with Retrofit wiring harness 
var.1 

 

The IMD 100 documentation is written anticipating an OEM (original equipment manufacturer) product 
use-cycle in a wind turbine. The envisioned cycle is described in the following figure. The description 
also explains the tasks, who is expected to execute the task, the location where the execution takes 
place and the supporting DEIF documentation for the task. Many details in these tasks depends on the 
actual implementation, which is why the IMD documentation will never stand alone. 
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1. IMD evaluation 
and purchase

• Task: Evaluation of the IMD

• Who: Customer buyers and 
engineers

• Supporting DEIF documents:

• Datasheet

• Function description

2. IMD integration 
in the customer’s  

product

• Task: Integrate the IMD in the turbine 
systems.

• Who: Customers R&D. 

• Where: Customers facility

• Output:

• Wiring diagram

• Cabinets specifications

• IMD configuration file

• Controller application SW (not IMD 
scope)

• Supporting DEIF documents:

• Datasheet

• Function description

• Integration manual

• Addendum to installation manual

• IMD Manager Installation 
instructions

• IMD Manager user manual

3. Installation

• Task: Install the IMD in the cabinet, 
install the cabinet in the hub.

• Who: Installation personnel.

• Where: Customer’s production 
facility.

• Supporting DEIF documents:

• Installation manual

• Installation check list

• Addendum to installation manual 

4. Initial 
configuration and 

verification

• Task:

• Upgrade the IMD SW if needed

• Configure the IMD with the 
configuration file

• Test the IMD installation

• Who: Commissioning or similar 
personnel. 

• Where: Customer’s production 
facility

• Supporting DEIF documents:

• Initial configuration and 
verification manual

• Configuration and verification 
check list

• IMD Manager Installation 
instructions

• IMD Manager user manual

5. Commissioning 
on site

• Task: Commission the whole 
turbine

• Who: Commissioning personnel

• Where: Turbine erection site

• Supporting DEIF documents:

• None. This task is entirely 
customer’s task based on 
customer’s documentation

6. Service and 
maintenance

• Task:

• Service of the IMD

• Replacement (disposal) of IMD

• Storage of spare parts

• Who: Service and warehouse 
personnel.

• Supporting DEIF documents:

• Service and maintenance 
manual

• IMD Manager Installation 
instructions

• IMD Manager user manual

 

Figure 4 Tasks and documentation overview 
 

The described product use-cycle might not apply as is for all customers, but the tasks are universal and 
can therefore be adapted. For example, if the SW upgrade, configuration and verification is done during 
the turbine commissioning, the applicable documentation can be used at this stage instead of a 
separate stage at the end of production. 
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16. Glossary 

16.1 Terms and abbreviations 

CAN Controller Area Network (communication protocol) 

IMD Integrated Motor Drive  

SCI Safety-Chain Input 

SCR Safety-Chain Relay 

SE Safe Energy 

SSI Synchronous Serial Interface 

USB Universal Serial Bus 

VLMS Virtual limit switches. SW limit switches based on resolver revolutions. 

16.2 Units 

Unit Unit 
Name 

Quantity name US 
unit 

US name Conversion Alternative 
units 

A ampere Current     

ºC degrees 
Celsius 

Temperature ºF Fahrenheit   

g gram Weight oz ounce 1 g = 0.03527 oz  

Hz hertz Frequency (cycles 
per second) 

    

kg kilogram Weight lb pound 1 kg = 2.205 lb  

m metre length ft foot (or feet) 1 m = 3.28 ft  

mA milliampere Current     

mm millimetre Length in inch 1 mm = 0.0394 in  

ms millisecond Time     

RPM revolutions 
per minute 

Frequency of 
rotation (rotational 
speed) 

    

s second Time     

V volt Voltage     

V AC volt 
(alternating 
current) 

Voltage 
(alternating 
current) 

    

V DC volt (direct 
current) 

Voltage (direct 
current) 

    

W watt Power     

Ω ohm Resistance     
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